Item Average Price Report Spreadsheet: Instructions

1. After opening the spreadsheet and selecting the Item Average Price Report Data tab of the workbook, single left click on the upper left corner (as shown

below) to select all cells in the spreadsheet.
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1 |District Publicati Letting_Date  Contract_NumLead Key  Project_Mumbe¢Vendor_Ran ltem_Code  Item_Description Item_Unit Item_Quan]
2 1 2018 2/6/2018 B307 19431 A019(431) 1 203-130B REMOWVAL OF PAV MARKINGS 5F
3 1 2018 2/6/2018 8307 19431 A019(431) 1 405-2604A WEDGE MILLING 5Y
4 1 2018 2/6/2018 8307 19431 A019({431) 1 405-435A SUPERPAVE HMA PAV INCL ASPH TON
3 1 2018 2/a/2018 8307 19431 A019(431) 1 502-0654A CONC CL40 AF Y 1
6 1 2018 2/6/2018 B307 19431 A019(431) 1 511-005A CONC WATERPROOF 5Y5 5Y
7 1 2018 2/6/2018 8307 19431 A019(431) 1 511-005B CONC WATERPROOF 5Y5 5Y 1
8 1 2018 2/a/2018 8307 19431 A019(431) 1 613-015A CRASH CUSHION, SACRIFICIAL-SA EACH
9 1 2018 2/6/2018 8307 19431 A019({431) 1 626-010A TEMPORARY TRAFFIC CONTROLS S5F
10 1 2018 2/a/2018 8307 19431 A019(431) 1 626-0404 BARRICADETY 3 EACH
11 1 2018 2/6/2018 B307 19431 A019(431) 1 626-0504A DRUMS EACH
12 1 2018 2/6/2018 8307 19431 A019(431) 1 626-0764 ARROW BOARD TY C HR
13 1 2018 2/a/2018 8307 19431 A019(431) 1 626-0924 TEMPORARY PAVEMENT MARKIN FT
14 1 2018 2/6/2018 8307 19431 A019({431) 1 626-100A MISCELLANEOUS TEMPORARY TR) LS
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2. After all cells are highlighted, select the “Data” tab on the ribbon and click the “Filter” option. This will activate filtering of all the provided columns.
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1 |District =~ Public ~ Letting_Date -~ Contract_N ~ Lead_Key - Project Mun * Vendor R * Item_Code - Item_Description = Iltem_Unit ~| ltem_Quar
2 1 2018 2/6/201a 8307 19431 A019(431) 1 203-130B8 REMOWVAL OF PAV MARKINGS SF
3 1 2018 2/6/2018 8307 15431 A019(431) 1 405-260A WEDGE MILLING 5Y
4 1 2018 2/6/2018 8307 15431 A019(431) 1 405-435A SUPERPAVE HMA PAV INCLASPH TON
3 1 2018 2/6/2018 8307 15431 A019(431) 1 502-065A COMC CL40 AF cY
B 1 2018 2/6/2018 8307 15431 A019(431) 1 511-005A CONCWATERPROOF 5Y5 5Y
T 1 20138 2/6/2018 8307 15431 A019(431) 1 511-005B CONCWATERPROOF 5Y5 5Y
8 1 2018 2/6/201a 8307 15431 A019(431) 1 613-015A CRASH CUSHION, SACRIFICIAL-SA EACH
9 1 2018 2/6/201a 8307 19431 A019(431) 1 626-010A TEMPORARY TRAFFIC CONTROL 5 5F
10 1 2018 2/6/201a 8307 19431 A019(431) 1 626-040A BARRICADETY 3 EACH
11 1 2018 2/6/2018 8307 15431 A019(431) 1 626-050A DRUMS EACH
12 1 2018 2/6/2018 8307 15431 A019(431) 1 626-076A ARROW BOARDTY C HR
12 1 2018 2/6/2018 8307 15431 A019(431) 1 626-092A TEMPORARY PAVEMENT MARKIM FT
14 1 2018 2/6/2018 8307 15431 A019(431) 1 626-100A MISCELLANEQUS TEMPORARY TRJ LS
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3. Filtering can now be customized to the user’s desired parameters. Below are examples of some good filtering options to use.

a. Filter by location: In column “A”, click on the drop-down option to reveal the available District location. From the menu, select the desired

location. More than one district location can be selected. In the example below, District 3 was the desired location.
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ca - fe | 2/6/2018
(4 A B c D E F G H I K
1 District = | Public ~ Letting Date |~ Contract_N ~ Lead_Key v | Project Nun ~ Vendor R ~ |ltem_Code - | Item_Description - |ltem_Unit| ~ | Item_Quantity ~ | Itg
4| Sort Smallest to Largest 8307 19431 A019(431) 1 203-1308B REMOVAL OF PAV MARKINGS SF 13677
2] sortlargest to Smallest 8307 19431 A019(431) 1 405-260A WEDGE MILLING SY 874
Sort by Color 3 8307 19431 A019(431) 1 405-435A SUPERPAVE HMA PAV INCLASPH TON 152.4
. 8307 19431 A019(431) 1 502-065A CONC CL40 AF cY 1195.2
. 8307 19431 A019{431) 1 511-005A CONC WATERPROOF 5YS SY 97.8
8307 19431 A019{431) 1 511-005B CONC WATERPROOF 5YS 5Y 1869.1
Number Filters ' 8307 19431 A019(431) 1 613-015A CRASH CUSHION, SACRIFICIAL-SA EACH 6
Search R 8307 13431 A019(431) 1 626-010A TEMPORARY TRAFFIC CONTROLS SF 741
..... |:| (Select All) 8307 19431 A019(431) 1 626-0404A BARRICADETY 3 EACH &
8307 19431 A019(431) 1 626-050A DRUMS EACH 119
8307 19431 A019(431) 1 626-076A ARROW BOARD TY C HR 12000
8307 19431 A019(431) 1 626-092A TEMPORARY PAVEMENT MARKIN FT 20935
8307 19431 A019(431) 1 626-100A MISCELLANEOUS TEMPORARY TR: LS 1
8307 19431 A019{431) 1 626-105A TRAFFIC CONTROL MAINTENANC HR 200
8307 19431 A019{431) 1 626-111A TEMPORARY RIGID RAISED PAVENEACH 660
8307 13431 A019(431) 1 626-140A SURFACE-MOUNTED TUBULAR M EACH 33
8307 19431 A019(431) 1 630-025A LONGITUDINAL PAVEMENT MAREFT 26149
8307 13431 A019(431) 1 631-010A RUMELE STRIPS MILE 1.111
8307 19431 A019(431) 1 632-005A CONC BRIDGE DECK REM CL A SY 11473.7
8307 19431 A019(431) 1 632-010A CONC BRIDGE DECK REM CLE Y 373.7
8307 19431 A019(431) 1 5501-05A EXPANSION JOINT (OBSOLETE 20: CF 247.3
B ] [ = 8307 19431 A019(431) 1 5501-20A 5P BRIDGE EACH 15
8307 19431 A019(431) 1 5501-25A SP BRIDGE LS 1
E=] 1 2Uly 2/ b 2U1E 8307 19431 A019{431) 1 5501-25B SP BRIDGE LS 1
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b. Filter by Bid Item: In column “H”, click on the drop-down option to reveal the available Bid Items or ltem_Codes. From the menu, select the

desired bid item. More than one item can be selected. In the example below, 405-435A was the desired location.
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A B C D E F G H | J K L
| 1 |District-T/Public v Letting Date |~ Contract_N - | Lead_Key| ~|Proiect Nun - Vendor R ~|item Code [~] Item_Description = | ltem_Unit| ~ | ltem_Quantity ~ |ltem_Bid_Price |~ |Item_T
6903 3 2018 1/23/2018 8303 13947 4] SotaAtez DISPUTE REVIEW BOARD- THREE I CA 8361 $1.00
6304 3 2018 1/23/2018 8303 13947 2| sotZtoa CLEARING & GRUBBING LS 1 $10,000.00
6305 3 2018 1/23/2018 8303 13947 Sort by Color » | REM OF BRIDGE EACH 1 $300,000.00
6306 3 2018 1/23/2018 8303 13947 REM OF CURB FT 2806 $2.00
6307 3 2018 1/23/2018 8303 13947 REM OF CURB & GUTTER FT 163 $3.00
6308 3 2018 1/23/2018 8303 13947 REM OF GUARDRAIL/BARRIER  FT 6070 41.50
6909 3 2018 1/23/2018 8303 13947  [edEilters " |OBLITERATION OF OLD ROAD LS 1 $2,000.00
6910 3 2018 1/23/2018 8303 13947 Search 2| | EXCAVATION cY 32534 $12.00
6911 3 2018 1/23/2018 8303 13947 [ 308-0154 [+| GRANULAR BORROW cy 14000 40.01
6912 3 2018 1/23/2018 8303 13947 -[1401-014A WATER FOR DUST ABATEMENT MG 1000 $20.00
6913 3 2018 1/23/2018 8303 13947 ~[1401-0204 _ |EXCAVATION AND REPAIR OF SOICY 150 $35.00
5314 3 2018 1/23/2018 8303 13947 jg ﬁ;g;ﬁ: | STR EXCAVATION SCH NO. 1 cy 3360 $17.00
6915 3 2018 1/23/2018 8303 13947 [ 405-2404 COMPACTING BACKFILL cY 348 $30.00
6916 3 2018 1/23/2018 8303 13947 -] 405-2454 FIBER WATTLE FT 9652 $2.00
6917 3 2018 1/23/2018 8303 13847 ~[1405-2458 STOME FILTER DAM TY cy 5 $115.00
6913 3 2018 1/23/2018 8303 13947 :E ﬁ?f&gi INLET PROTECTION EACH 15 $100.00
6919 3 2018 1/23/2018 8303 13947 -] 405-410A 3/4" AGGR TY B FOR BASE TON 17561 $17.00
6920 3 2018 1/23/2018 8303 13947 -] 405-4154 €55-1 DIL EMUL ASPH FOR TACK C GAL 1877 45.00
6321 3 2018 1/23/2018 8303 13947 ] 405-435A MISC PAV Sy 122 430.00
6922 3 2018 1/23/2018 8303 13947 E ﬁ:ji;i APPROACH EACH 19 $1,300.00
6923 3 2018 1/23/2018 8303 13947 - £ WEDGE MILLING sY 5857 $5.00
6924 3 2018 1/23/2018 8303 13947 [ o l ’ p— ] SUPERPAVE HMA PAV CLSP-T  TOM 187 $100.00
6925 3 2018 1/23/2018 8303 13947 SUPERPAVE HMA PAV CLSP-NS  TON 37 $85.00
6926 3 2018 1/23/2018 8303 13847 AUE5U5T; 1oL InLa SUPERPAVE HMA PAY INCL ASPH TON 8,929.00 $88.00
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c. Filter by Publication Year: In column “B”, click on the drop-down option to reveal the available Publication Years. These represent the
construction year of each of the projects available in the data. From the menu, select the desired year. More than one year can be selected. In

the example below, 2018 was the desired publication year.
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up Su Frem From From From Other Exlstm_g Refresh i A‘L Sort Y Text to Remove Data Consohdate What_-If Group Ungr
Access Web  Text Sources~  Connections  All= == EOITLINKS % Advanced | Columns Duplicates Validation - Analysis ~ > >
Outl Get External Data Connections Sort & Filter Data Tools
Bl - Je | Publication_Year
Fﬁ D E F G H I ]
em_{.DisirideDuhi ~ lletting_Date |~ Contract_N v |Lead_Key |~ Project_Nun ~ Vendor_R v Item_Code -T Item_Description - | ltem_Unit * | I
El Sort Smallest to Largest 8303 13947 A013(930) 1 405-435A SUPERPAVE HMA PAV INCL ASPH TON
fg_,|, Sort Largest to Smallest 8303 13947 A013(930) 2 405-435A SUPERPAVE HMA PAV INCLASPH TON
Sort by Color 3 8303 13947 A013(930) 3 405-435A SUPERPAVE HMA PAV INCLASPH TON
8304 19814 A019(814) 1 405-435A SUPERPAVE HMA PAY INCLASPH TON
8304 19814 A019(814) 2 405-435A SUPERPAVE HMA PAY INCLASPH TON
8304 19814 A019(814) 3 405-435A SUPERPAVE HMA PAY INCL ASPH TON
Number Filters ' 8317 19965 A019(965) 1405-435A  SUPERPAVE HMA PAV INCL ASPH TON
Search > 8317 19965 AO019(965) 2 405-435A SUPERPAVE HMA PAY INCL ASPH TON
8317 19965 AO019(965) 3 405-435A SUPERPAVE HMA PAV INCL ASPH TON
8317 19965 AO019(965) 4 405-435A SUPERPAVE HMA PAV INCL ASPH TON
8321 20225 A020(225) 1 405-435A SUPERPAVE HMA PAV INCL ASPH TON
8321 20225 A020(225) 2 405-435A SUPERPAVE HMA PAV INCL ASPH TON
8322 18872 AD18(872) 1 405-435A SUPERPAVE HMA PAV INCLASPH TON
8322 18872 AD18(872) 2 405-435A SUPERPAVE HMA PAV INCLASPH TON
8322 18872 AD18(872) 3 405-435A SUPERPAVE HMA PAY INCLASPH TON
8328 19947 A019(947) 1 405-435A SUPERPAVE HMA PAY INCLASPH TON
8328 19947 A019(947) 2 405-435A SUPERPAVE HMA PAY INCL ASPH TON
8328 19947 A019(947) 3 405-435A SUPERPAVE HMA PAY INCL ASPH TON
8333 19415 A019{415) 1 405-435A SUPERPAVE HMA PAY INCL ASPH TON
8333 19415 A019(415) 2 405-435A SUPERPAVE HMA PAV INCL ASPH TON
8441 13962 A013(962) 1 405-435A SUPERPAVE HMA PAV INCL ASPH TON
ox I Cancﬂj 8441 13962 A013(962) 2 405-435A SUPERPAVE HMA PAV INCL ASPH TON
8445 18950 AO018(950) 1 405-435A SUPERPAVE HMA PAV INCL ASPH TON
Bb9 3 2018 JLIA01E 8445 18950 AO018(950) 2 405-435A SUPERPAVE HMA PAV INCLASPH TON
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d.

Filter by Quantity: In column “K”, click on the drop-down option to reveal the available item quantities. From the menu, select the desired

guantities. More than one quantity can be selected. In the example below, six project quantities were selected to span a desired quantity range.
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Get External Data Connections Sort & Filter Drata Tools Outline P}
Bl - Jx | Publication_Year
A B C D F G H I ] K L
1 |District-T|Public-TlLetting_Date + Contract N v Lead_Key v Project_Mun v Vendor_R ~ |Item_Code -T| ltem_Description - | ltem_Unit ~ Itemiﬂuantitﬁ\Item_ﬂid_Price - | ltem_T|
6926 3 2018 1/23/2018 8303 13947 A013(930) 1 405-435A SUPERPAVE HMA PA, 4|  Sort Smallest to Largest $88.00
7037 3 2018 1/23/2018 8303 13947 A013(930) 2 405-435A SUPERPAVE HMA PA | ﬁl Sort Largest to Smallest 591.75
7148 3 2018 1/23/2018 8303 13947 A013(930) 3 405-435A SUPERPAVE HMA PA Sort by Calor $90.13
8251 3 2018 4/3/2018 8328 19947 A019(947) 1 405-4354A SUPERPAVE HMA PA | ) . o 568.00
K Clear Filter From "Ttem_Quantity

8276 3 2018 4372018 8328 19947 A019(947) 2 405-435A SUPERPAVE HMA PA 568.00
8301 3 2018 4/3/2018 8328 19947 A019(947) 3 405-4354A SUPERPAVE HMA PA | 565.69
2409 3 2018 7/10/2018 8441 13962 A013(962) 1 405-435A SUPERPAVE HMA PA , e e $100.00
B486 3 2018 7/10/2018 8441 13962 A013(962) 2 405-4354A SUPERPAVE HMA PA | Search 5111.85
8798 3 2018 7/31/2018 8446 20796 AD20{796) 1 405-435A SUPERPAVE HMA PA |V | .. (select Al $70.00
2847 3 2018 7/31/2018 8446 20796 A020(796) 2 405-4354A SUPERPAVE HMA PA | -[]75 581.00
8396 3 2018 7/31/2018 8446 20796 AD20{796) 3 405-435A SUPERPAVE HMA PA, ~[1237 $85.00
2945 3 208 7/31/2018 8445 20796 AD20(796) 4 405-435A SUPERPAVE HMA PA :E ‘E :6 $85.00
9015 3 2018 7/24/2018 8447 13387 A013(387)/A01: 1 405-435A SUPERPAVE HMA PA 3330 $70.00
9216 3 2018 7/24/2018 8447 13387 A013(38?}f A0L: 2 405-4354A SUPERPAVE HMA PA | -[13,365.00 §76.00
9417 3 2018 7/24/2018 8447 13387 AD13(387)/A01: 3 405-435A SUPERPAVE HMA PA , ¥ 3,595.00 477.75
10104 3 208 10/30/2018 8465 20842 AD20(842) 1 405-435A SUPERPAVE HMA PA :: ;;i;gg $84.00
10273 3 2018 10/30/2018 8465 20842 AD20(842) 2 405-435A SUPERPAVE HMA PA L #18,525.00 $70.00
10442 3 2018 10/30/2018 8465 20842 A020(842) 3 405-4354A SUPERPAVE HMA PA | -] 17,500.00 $90.00
10611 3 2018 10/30/2018 8465 20842 AD20(842) 4 405-435A SUPERPAVE HMA PA, -l 21703 $82.00
27963 -] 40500

27964

27965

[ 0K ] ’ Cancel

27966

27967

2TFORS
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4. For a graphical scatter plot view of the filtered data:
a. Highlight the columns for “Qauntity” and “Bid_Price.”
b. Select the “Insert” tab.
c. Select the “Scatter” ploticon.
|E| Hw9-¢ d |: EstimatorDataDump.csv - Microsoft Excel
Home Insert Page Layout Formulas Data Review View Developer Add-Ins Bluebeam ProjectWise QUICK STREETS Team
o= _ EE [ i Y = .t =] y L =1 A =k lz, d
B EBED® o ke Dl xux 5 @ BB 4 4@ T
PivotTable Table | Picture Clip Shapes SmartArt Screenshot | Column  Line Pie Bar Area |Scatter | Other Line Column Win/Loss | Slicer | Hyperlink | Text Header WordArt Signature Object | Equal
M Art M = - M M - M v |Charts - Box & Footer - Line - M
Tables Tlustrations Charts Scatter parklines Filter Links Text 5
L1 - fr| Quantity ol i
A B C D E F G bl °os | "J:Tj" K L M N 0] P
1 |District|-T|Year |-T|lLetting |~ |Month| ~|Contrac - |Lead K ~ | Project - | Rank Scatter with only Markers Quantity -7 | Bid_Price | ~ |ltem_T¢ ~ | Bid_Tot = Percent ~
18812 3 2018 2/27/2018 2 8317 19965 A019(965) T e Ol T 40900 57.5] 2351750 4212200 55.83
18867 3 2018 2/27/2018 2 8317 19965 A019(965) 40900 54.3| 2220870 4511961 49,22
18922 3 2018 2/27/2018 2 8317 19965 AD19(965) Use it when the values are not in 40900 65| 2658500 4599164 57.8
x-axis order or when they represent
18977 3 2018 2/27/2018 2 8317 19965 AD19(965) separate measurements. 40900 58.7| 2400830 4712349 50.95
19743 3 2018 7/31/2018 7 8446 20796 AD20(796) RPAV TON 17500 70] 1225000 5041098 24.3
19785 3 2018 7/31/2018 7 8446 20796 AD20(796) b Al Chart Types RPAV TON 17500 81] 1417500 5055554 28.04
19827 3 2018 7/31/2018 7 8446 20796 AD20(796) s =uo-ssarsurcRPAV TON 17500 85| 1487500 5955070 24.98
19869 3 2018 7/31/2018 7 8446 20796 AD20(796) 4 405-435A SUPERPAV TON 17500 85| 1487500 6118000 24.31
19932 3 2018 7/24/2018 7 8447 13387 AD13(387), 1 405-435A SUPERPAV TON 21703 70] 1519210 20921628 7.26
20104 3 2018 7/24/2018 7 8447 13387 A013(387), 2 405-435A SUPERPAV TON 21703 7B 1649428 21427528 7.7
20276 3 2018 7/24/2018 7 8447 13387 AD13(387), 3 405-435A SUPERPAV TON 21703 77.75] 1687408 22313296 7.56
22414 3 2017 3/7/2017 3 8194 13924 A013(924) 1 405-435A SUPERPAV TON 60510 47] 2843970 3996554 71.16
22449 3 2017 3/7/2017 3 81904 13924 A013(924) 2 405-435A SUPERPAV TON 60510 46| 2783460 4059677 68.56
27ARA 2 17 afz7zHhna7 2 Q10a 120724 AN 2Q2AY 2 ANE_A2ICA CHIDERDAN Tkl RNR1N C1 K 211RIRE A2a7FNNn Fi el
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d. Pick an area to the right of the data columns to draw a box for the scatter plot.

@‘ = s A R | |= EstimatorDataDump.csv - Microsoft Excel Chart Tools
Home Insert Page Layout Formulas Data Review View Developer Add-Ins Bluebeam ProjectWise QUICK STREETS Team Design Layout Format
Chart 3 -( |
L M N 0 P Q R S T U \ W X Y Zz AA AB AC AD AE

1 Quantity|-T |Bid_Price | ~ |Item_T¢ ~ |Bid_Tot = Percent ~
18812 40800 57.5| 2351750 4212200 55.83 Bid Price
18867 40900 54.3| 2220870 4511961 49.22 -
18922 40900 65| 2658500 4599164 57.8 120
18977 40900 58.7| 2400830 4712349 50.95
19743 17500 70| 1225000 5041098 24.3
19785 17500 81| 1417500 5055554 28.04 *
19827 17500 85| 1487500 5955070 24.98 100
19869 17500 85| 1487500 6118000 24.31 *
19932 21703 70| 1519210 20921628 7.26
20104 21703 76| 1649428 21427528 7.7 * *
20276 21703 77.75| 1687408 22313296 7.56 80 *
22414 60510 47| 2843970 3996554 71.16 * ‘
22449 60510 46| 2783460 4059677 68.56 * * ' *
22484 60510 51.5| 3116265 4297000 72.52 ‘ * ¢ * ‘ *
22519 60510 61| 3691110 4947033 74.61 60 '3 [ * gid Pri
22556 44400 55| 2442000 3443970 70.91 ¢ * * ‘ ¢ Biefrice
22596 44400 50.8| 2255520 3786970 59.56 * * * *
22636 44400 56| 2486400 3859659 64.42 s
22676 44400 56.75| 2519700 4119989 61.16 40
22835 14466 53| 766698 2361613 32.47
22892 14466 52| 752232 2383030 31.57
22949 14466 57| 824562 2436000 33.85
23006 14466 75| 1084950 3260112 33.28 20
23219 21497 58| 1246826 4754000 26.23
23270 21497 60| 1289820 4814200 26.79
23412 35650 67.75| 2415288 8542483 28.27
23496 35650 64.25| 2290513 8695904 26.34 0 . . . . . . . .
23856 13000 58.8| 7064400 3149707 24.27 0 10000 20000 30000 40000 50000 60000 70000 20000
23903 13000 65| 845000 3177641 26.59 B
23950 13000 66.2| 860600 3396339 25.34
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5. To add a Trendline through the scatter plot (Note: This step through is for selection of a power Trendline, other options may be more appropriate):

9|Page

a. Select the “Layout” tab.
b. Pick the “Trendline” icon.
c. Select the “More Trendline Options. . .”

@l Hw-o-0|= EstimatorDataDump.csv - Microsoft Excel ‘ Chart.Tools
Home Insert Page Layout Farmulas Data Review View Developer Add-Ins Bluebeam ProjectWise QUICK STREETS Team Design Layout Format
Chart Area M N = = : i Chart Name:
nd [P in| o] os] i | [ [ ) [Pl i

8y Format Selection

Chart 3

# Bid_Price

80000

Picture Shapes Text Chart  Axis Legend Data Data Axes  Gridlines Plot  Chart Chart 3-D (Trendline| Lines Up/Down Error
&3 Reset to Match Style < Box Title ~  Titles - - Labels ~ Table - - Area - Wall - Floor - Rotation = Bars Bars ~
Current Selection Insert Labels Axes Background . None
18867 \=;| Removes the selected Trendline or all
Trendlines if none are selected
18922 J Linear Trendline
H H il Adds/sets a Linear Trendline for the
18977 BId_Prlce selected chart series
19743 5 Expenential Trendline
19785 120 \:—I Adds/sets an Exponential Trendline for [
the selected chart series
19827 J Linear Forecast Trendline
L Adds/sets a Linear Trendline with 2 period
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100 \:—I Adds/sets a 2 Period Moving Average
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Select the “Power” Trendline option.
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Appendix A (Column Headings)

Column Title Description
District Regional administrational area associated with a contract. Main District offices are in the following locations:
1 - Coeur d’ Alene (Northern Idaho)
2 — Lewiston (Northern central part of pan handle part of Idaho)
3 — Boise (central Idaho)
4 — Shoshone (South central Idaho)
5 — Pocatello (South East Idaho)
6 — Rigby (North East Idaho)
7 — LHTAC (Local Highway Technical Assistant Council, can be any section of Idaho)
Year Year of the letting date
Month Month of the letting date
Letting_Date Date associated with the bid opening of the project.
Contract Contract identifying number that can represent a single or group of projects.
Lead_Key Lead project key identifier associated with a contract.
Project_Description Project description/location given to the lead key number associated with a contract.
Bidder_Rank Ranking number given to a contractor that has submitted a bid on a project. A number 1 signifies the winning bid
(or Rank) representing the lowest overall bid total for a contract.
ltem Bid item identifier

Item_Description
Unit

Quantity
Bid_Price
ltem_Total
Bid_Total
Perc_Bid

(or Percent_Bid)
Fund_Type
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Bid item description

Bid item unit of measure

Engineering estimated quantity for a given bid item

Contractor bid price given for a bid item

Total bid amount for a given bid item by a contractor

Total bid amount for the contract by a contractor

Iltem_Total / Bid_Total (useful for items that are bid as a percentage of the overall bid such as mobilization)

Funding type associated with the contract: Federally funded, State funded, or Other funded.



